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INTRODUCTION
Affinity Photo (AP)
There are over 20 photo editing programs out there.
Unsurprisingly, each has ups and downs, each has its fans
and critics.The purpose of this book is not take sides nor
make comparisons, but to explain AP’s features and
demonstrate its use. Whether you choose to buy AP or a
competitor is up to you.There are lots of reviews, many of
them comparing AP with Photoshop, the program that
AP most closely resembles. Here are a few reviews to get
you started if you’re interested. #1, #2, #3.

Background. During my photo site’s early days I was a
Nik software beta tester.That lead to, what I believe, is
the most complete set of Nik reference material and
tutorials in existence. I feel there’s a place for similar AP
material - for my personal use if nothing else.Thus this
AP User Guide. An aside - Serif published an AP
Workbook ($49.99).

There are lots of AP books and videos available. Keep in
mind that the ultimate source is the material from Serif.
This link takes you to 100% of Serif ’s AP material. If you
prefer videos, try the Affinity Photo YouTube channels.
My free eBook will be updated regularly.This means
that, compared to hardcover books & videos, it remains
current. Also, in contrast to hardcover books & video
tutorials, my book has numerous links to external
reference material, including, every word on AP that
Serif has published. Finally, the book’s photo editing
examples section will have material that can be
downloaded for use while following along with examples.
The book is available at my website.

Are you a Nik Collection fan? How about Topaz? These
two Photoshop plugins are both compatible with AP.
How to load, access and use them is covered in Part 2.

Notes 2
The first two parts of the book rely heavily on Affinity Photo’s help
documentation in the form of links. Because of this dependence on
linked content, if the book is used offline then you will lose access to

its most valuable content.

For convenience and ease of use,The footer at the bottom of every

page has four links. From left to right, the links take you to:
The Table of Contents

Serif ’s Affinity Photo official help document
Serif ’s Affinity Photo official video tutorials

The Index
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Notes 1
This book is based on AP-related blog posts at my Photo

Improvement website.
Except when noted otherwise, linked material is from AP’s
help document (accessed via the program’s Help Menu).

This eBook was made using Affinity Publisher. One of Publisher’s

Personas is Photo which accesses AP without leaving Publisher.
Convenient.

‘Serif ’ and ‘Affinity’ are registered trademarks of Serif (Europe) Ltd.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://www.photography-raw.com/affinity-photo-vs-photoshop/
https://designshack.net/articles/software/affinity-photo-vs-photoshop/
https://envato.com/blog/affinity-photo-replace-adobe-photoshop/
https://www.photography-raw.com/affinity-photo-vs-photoshop/
https://edknepleyphoto.photos/
https://edknepleyphoto.photos/table-of-contents/
https://affinity.serif.com/en-us/photo/workbook/
https://affinity.help/photo/en-US.lproj/index.html
https://www.youtube.com/channel/UCQZN-kIrZUQyoTnexM3jJAw
https://edknepleyphoto.photos/
https://affinity.help/photo/en-US.lproj/index.html
https://edknepleyphoto.photos/
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.serif.com/en-us/tutorials/publisher/desktop/video/337462814
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PART 1 - WORKSPACE

The purpose of this part is to
review the Affinity Photo
workspace. Familiarity with

the workspace and its User Interface
is essential.
The three images on the previous page
show examples of what’s covered here.
Not exhaustive by any means, but
more than enough to get you started.
These images illustrate the three

workspace areas where that affect
what you can do in AP and how.
The 3-P’s
Preferences
Persona
Panels
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https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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to

View > Toggle UI to
toggle interface on/off

(or click Tab)
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Workspace Overview (More about Workspace Modes) (UI Overview YouTube)

NOTE: I use AP for Windows and am writing
from that perspective. Recently I’ve found that
there are minor differences between the Mac &
Win versions such as menu access to the AP
Preferences settings shown here:
Edit > Preferences forWin (Affinity Photo >
Preferences for Mac
If you are a Mac user, you can do the AP
community a big favor by suggesting changes -
which, after checking - I’ll incorporate.Thanks
in advance. For starters, MEB , Serif QA
Support, provided the items in the next column.
Most features/functionality and menus are the

same but these are a few exceptions:
keyboard shortcuts/modifiers keys differ
the Windows version provides a couple more
export formats
the Mac version includes an additional RAW
engine provided by macOS: Apple (Core Image
RAW); Windows version only has our own:
Serif Labs
additional Edit > Paste Special command on
Windows (not present on Mac)
a few differences in the Window menu
command due to the way the OS manages
windows

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Workspace/workspaceModes.html?title=About%20workspace%20modes
https://youtu.be/EfIzR3QD95A


Here’s a Preferences example that
you may find useful. AP’s

default user interface style is Dark as
shown at the right. If you’re like me, it
will drive you crazy. Clicking on
Preference’s User Interface control
offers a host of options and the one I
want is shown below. I find the
resulting Light UI much easier to
read. Compare the right side of each
screen capture; lack of contrast = lack
of visibility
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You eventually may want to make some changes to
AP’s functions, layout, appearance, etc.

Edit > Preferences for Win (Affinity Photo >
Preferences for Mac)
brings up the Preferences control box shown below.
There are eight controls.The example shown,Tools, is

typical.This book won’t go into details.They’re in the AP
documentation. The important thing is to know where to
find these valuable items.

Preferences
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Workspace Customization

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Workspace/preferences.html?title=Preferences
https://affinity.help/photo/en-US.lproj/index.html
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Before Develop

Develop Persona: For development of raw images

Photo Persona: The default Persona for photo editing.

After Develop

Left Image
After RAW
conversion in

Develop Persona

Right Image
Open Nik Color

Efex Pro 4 plugin
from the Photo
Persona & then:
High Key filter
Polaroid Transfer
filter for the funky

edge
Image Border filter
for the B&W side-

border
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Here are the Affinity Photo Persona:

Photo Persona: The default Persona for photo
editing

. Develop Persona: For development of raw
images.
Initially, the book will cover just the Develop and Photo
Persona.These are what the majority of us use nearly all
of the time. Once those two are complete, the other four
will be considered.

Liquify Persona: For distortion of image areas,
retouching and warping effects.

Tone Mapping Persona: For tone mapping
images.

Export Persona: Output an image, layer, or slice
to a variety of image formats.
Panorama Persona: Different from other Persona - only
available when making a stitched panorama.

Persona & Panels

Personas offer different ways of working within
Affinity Photo (AP). For normal photo editing

tools the default Photo Persona is used. However, AP
has five additional Persona, each with its own design
environment - Studio Panels, tools, features and
functions.

NOTE: AP’s preference settings, that we just
examined, do not change when switching to a different
Persona. However, Persona can be customized via their
Studio Panels..

More about Persona Toolbar

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Workspace/personaToolbar.html?title=Persona%20Toolbar
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View Used to move the visible portion of your document in
the Document view.

Zoom Used to change the zoom level of your page or canvas in
the Document view.

Red Eye
Removal

Quickly fixes the red eye effect in your photos and
preserves the detail of the eye.

Blemish
Removal Enables you to remove small imperfections from images.

Overlay
Paint

Allows you to add areas of the selected overlay
adjustment.

Overlay
Erase

Allows you to remove areas of the selected overlay
adjustment.

Overlay
Gradient

Allows you to apply linear, elliptical, or radial graduated
opacity to the selected overlay adjustment

Crop Removes areas of an image to improve composition

White
Balance

Removes undesirable color casts by adjusting the
'temperature' of the light. Default value is the 'As shot'
White Balance setting from your camera.

Develop tools allow you to make and modify adjustments applied
to an image in the Develop Persona.

Photo & Develop
Persona Tool

Panels
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View Used to move the visible portion of your document in the Document view

Move Allows you to select layer content and move, rotate, and resize the selected content

Color Picker Allows you to sample colors from anywhere on your document or screen

Crop Removes areas of an image to improve composition

Selection Brush Allows you to select a region of your image by painting

Flood Select Enables you to select pixels of a similar color

Marquee Select Provide various ways of applying selections to your image

Flood Fill Fill in areas of your page, selection, or object with a single click (replacing the color of pixels).

Gradient Apply and adjust gradient colors on a layer

Painting Tools Lays down pixels on the page, creating strokes with anti-aliased edges

Paint Mixer Digitally simulate the mixing of wet paint applied to a canvas

Erase Erase from any area of your. Erased pixels become transparent

Dodge Brush Control exposure and make areas of a photo lighter

Clone Brush Paints samples from one part of an image onto another

Undo Brush Selectively undo modifications to individual pixels, restoring them to a previous history state

Blur/Sharpen Blur or sharpen edges

Inpainting Restores damaged, lost, deteriorated or unwanted areas of an image

Pen/Node Draw lines and shapes

Shape Collection of geometric shapes, such as squares, circles and polygons

Text Paragraph and artistic text options

Perspective Gives your image a three-dimensional look by applying a warp along one or more planes

Zoom Used to change the zoom level of your page or canvas in the Document view

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Retouching/retouching_redEye.html?title=Removing%20Red%20Eye
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Retouching/retouching_blemishes.html?title=Removing%20blemishes
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/usingOverlays.html?title=Using%20overlays
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/usingOverlays.html?title=Using%20overlays
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/usingOverlays.html?title=Using%20overlays
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/usingOverlays.html?title=Using%20overlays
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Adjustments/adjustment_whiteBalance.html?title=White%20Balance%20adjustment
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/raw.html?title=Developing%20a%20raw%20image
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/en-US.lproj/index.html?page=pages/GetStarted/view.html?title=Viewing
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_move.html?title=move%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_clrpicker.html?title=Color%20Picker%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_crop.html?title=Crop%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_brush.html?title=Painting%20pixel%20selections
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_flood.html?title=Flooding%20pixel%20selections
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_marquee.html?title=Marquee%20pixel%20selections
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_flood.html?title=Flooding%20pixel%20selections
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_gradient.html?title=Gradient%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_paintBrush.html?title=Paint%20Brush%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_paintMixerBrush.html?title=Paint%20Mixer%20Brush
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_eraseBrush.html?title=Erase%20Brush%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_dodgeBrush.html?title=Dodge%20Brush%20ToolS
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_cloneBrush.html?title=Clone%20Brush%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_undoBrush.html?title=Undo%20Brush%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_blurBrush.html?title=Blur%20Brush%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_inpaintingBrush.html?title=Inpainting%20Brush%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_pen.html?title=Pen%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_squareStar.html?title=Square%20Star%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Text/frameText.html?title=Frame%20text
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_perspective.html?title=Perspective%20Tool
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_zoom.html?title=zoom%20Tool
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When you select a new tool, the context toolbar switches
to show the relevant commands and options

ERASE BRUSHTOOL
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Context Toolbar

The context toolbar shows the options available
for the currently selected tool.

CROPTOOL

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html


Photo & Develop Persona Toolbars

•Show Clipped Highlights—when selected, highlight
areas which suffer from loss of detail due to clipping
are displayed on the image in red.
•Show Clipped Shadows Show Clipped Shadows—
when selected, shadow areas which suffer from loss of
detail due to clipping are displayed on the image in
blue.
•Show Clipped Midtones Show Clipped Tones—
when selected, midtone areas which suffer from loss of
detail due to clipping are displayed on the image in
yellow

•Sync Before—updates the 'Before' view
using the settings applied in the 'After'
view.
•Sync After—removes all the settings
applied in the 'After' view to return the
image to the 'Before' view.
•Swap—switches the applied settings of
the 'Before' and 'After' views

•None—displays in full view.
•Split—displays in split view for
side-by-side 'Before - After'
comparison.
•Mirror—displays a split
mirrored view for side-by-side
'Before - After' comparison.

•Insert behind the selection—new
objects are added below the
currently selected object(s).
•Top—when selected, new objects
are added at the top of the layer.
•Inside—when selected, new objects
are added inside the current
selection.
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Control layer rasterisation
behaviour and enable
supporting on-screen alerts

Displays a pop-up dialog
allowing you to align and
distribute selected object(s).

•Move to Back—repositions the selected layer(s) at
the bottom of the Layers panel.
•Back One—moves the selected layer(s) down one
position in the Layers panel.
•Forward One—moves the selected layer(s) up one
position in the Layers panel.
•Move to Front—repositions the selected layer(s) at
the top of the Layers panel.

(More about Toolbars)

17 Part 1 - Workspace Go To Serif ’s Affinity Photo HelpGo to TOC

• Switch to Quick Mask— mode to create
selections using the painting tools
Customize settings from the pop-up menu

Force Pixel Alignment— is particularly useful for web
graphic development

Snapping—simplifies the positioning of crop areas,
selection areas, and layer content

Move By Whole Pixels—useful for repositioning an
object by a particular pixel distance

Invert—selects the portion of the current layer
outside the current selection

Deselect—deselects all pixels in current selection
Select All—Selects pixels on entire layer

Auto White Balance—applies white balance
adjustment

Auto Colors—applies color adjustment
Auto Contrast—applies contrast adjustment
Auto Levels—applies levels adjustment .

View > CustomizeToolbar

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Workspace/toolbar.html?title=Toolbar
https://affinity.help/photo/en-US.lproj/index.html
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32-bit Preview
✓Adjustment The Adjustment panel presents color and tonal adjustments under adjustment type (e.g., HSL

Adjust) as a series of preset thumbnails.
Assets
Batch

�Brushes Pre-designed brushes available as selectable thumbnails. With the brush tool selected, the
selected thumbnail sets the type of brush to be used.

✓Channels The Channels panel displays the color channels and alpha channel for the whole image or
selected layer.

Character
✓Color The Color panel is used to choose color for various brush tools and to apply color to the

stroke and fill of vector shapes, lines, and text.
EXIF
✓Effects Apply layer effects directly to layer contents using the Effects panel.
Glyph Browser
✓Histogram Shows the distribution of RGB and Luminance values for the image, layer, or current

selection.
✓History Tracks changes and shows each state as a labeled entry in a list.This allows you to return to

earlier points in time.
Info
✓Layers The Layers panel lets you manage your design more easily by assembling layer content onto

separate layers, each layer being independently controlled.
Library
Macro
✓Navigator Lets you zoom into your design and pan around to view specific areas. You can also add,

remove and switch between custom view points,.
Paragraph
✓Swatches The Swatches panel makes it easy to use predefined colors, and also to define, store and reuse

your own selection of colors
Scope
Snapshots
Sources
Stock
Styles
Text Styles
✓Transform Selected layer content is easily moved, resized and sheared by adjusting the values in the

Transform panel

Photo Persona Default Panels (with Links to AP docs)
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Photo Persona Panels

The figure to the right is
the default Studio Panel.
The individual panels, e.g.
Histogram, are organized
into three groups.
You can add/remove any
panels you want as shown
in the table to the right.
Further, you can group &
organize them any way
that you wish.
There are nearly 30 Photo
Persona panels - too many

to cover in detail here.
Check the official AP
document.
However, I will cover all
of the the most
important panels in Parts
2 & 3 of this book, which
will explain them in the
context of editing an
actual image.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/adjustmentsPanel.html?title=Adjustment%20panel%20(Photo%20Persona%20only)
https://
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/adjustmentsPanel.html?title=Adjustment%20panel%20(Photo%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/adjustmentsPanel.html?title=Adjustment%20panel%20(Photo%20Persona%20only)
https://)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/brushesPanel.html?title=Brushes%20panel%20(Photo%20Persona%20only)
https://)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/channelsPanel.html?title=Channels%20panel%20(Photo%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/clrPanel.html?title=Color%20panel%20(Photo%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/layerFxPanel.html?title=Effects%20panel%20(Photo%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/histogramPanel.html?title=Histogram%20panel
https://.help/photo/en-US.lproj/index.html?page=pages/Panels/historyPanel.html?title=History%20panel
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/historyPanel.html?title=History%20panel
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/layersPanel.html?title=Layers%20panel%20(Photo%20and%20Export%20Persona)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/navigatorPanel.html?title=Navigator%20panel
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/swatchesPanel.html?title=Swatches%20panel%20(Photo%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/transformPanel.html?title=Transform%20panel
https://affinity.help/photo/en-US.lproj/index.html
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� 32-bit Preview provides configurable exposure and gamma controls to preview the vast tonal range of a 32-bit document
without tonally modifying it

� Basic The Basic Panel provides standard adjustments which can be applied to an image.

� Details The Details Panel provides adjustments to refine the edges of images and remove (or add) noise.

� EXIF
EXIF information is normally included in photos created on modern digital cameras; it is written into
the image file automatically and provides a record of camera details, exposure settings, aperture settings,
author/copyright, and more, from your image. In Affinity Photo, this information is displayed in the
EXIF panel.

� Focus reports the camera settings at the point at which the image was captured. Reported settings include
Mode, Beam, CoC and Hyperfocal.

✓Histogram Shows the distribution of RGB and Luminance values for the image, layer, or current selection.

✓History Tracks changes and shows each state as a labeled entry in a list.This allows you to return to earlier
points in time.

� Info The Info panel provides continuous data readings using samplers.These can sample from the current
position of the cursor or from a placed target position

� Lens The Lens Panel provides adjustments which can be used to correct lens distortions which can appear in
images.

✓Navigator Lets you zoom into your design and pan around to view specific areas. You can also add, remove and
switch between custom view points,.

� Overlays The Overlays Panel (in combination with the Overlay tools) allows you to apply standard adjustments to
isolated areas of a raw image.

� Scope
The Scope panel provides a variety of charts which allow you to examine the distribution of luminance
and chrominance in an image, allowing you to judge whether tonal or color correction is needed. It can
be used as an alternative to, or in combination with, the Histogram panel.

� Snapshots
The Snapshots Panel serves the same function as the Snapshots Panel in the main Photo Persona. You
can 'save' partly developed raw images, choosing to pick up a saved snapshot at any point while in
Develop Persona.

� Tones The Tones Panel provides adjustments for correcting the tonal and color values of pixels in an image.

Develop Persona Default Panels (with Links to AP docs)
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Develop Persona Panels

The figure to the right is
the Studio Panel.
The individual panels, e.g.
Histogram, are organized
into three groups.
This is the default setup.
You can include any panel
you want. Further, you can
group & organize any way
that you wish.
There are fourteen

Develop Persona panels as
shown in the table at the
right.
Follow the links to the
official AP documentation
for complete details

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/32bitPanel.html?title=32-bit%20Preview
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/raw_panelBasic.html?title=Basic%20Panel%20(Develop%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/raw_panelDetails.html?title=Details%20Panel%20(Develop%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/exifPanel.html?title=EXIF%20panel
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/raw_panelFocus.html?title=Focus%20Panel%20(Develop%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/histogramPanel.html?title=Histogram%20panel
https://.help/photo/en-US.lproj/index.html?page=pages/Panels/historyPanel.html?title=History%20panel
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/historyPanel.html?title=History%20panel
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https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/navigatorPanel.html?title=Navigator%20panel
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/raw_panelOverlays.html?title=Overlays%20Panel%20(Develop%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/scopePanel.html?title=Scope%20panel
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https://affinity.help/photo/en-US.lproj/index.html?page=pages/Raw/raw_panelTones.html?title=Tones%20Panel%20(Develop%20Persona%20only)
https://affinity.help/photo/en-US.lproj/index.html
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The Tools that go along with different AP
Persona, just as the Studio Panels, vary from
Persona to Persona. Further, the tools are
customizable. Look at #4 on the previous
page - Customize Tools. Open that and
you’re presented with something like in the
right far right column.
Close examination shows very few Tools in
common between these two Persona.
Actually, the Hand and the Magnifying
Glass are the only AP tools common to every
Persona.

To carry on with this Develop vs. Photo
Persona comparison, look at Studio Panel
comparison at the right.There is very little in
common between the two.

The comparison illustrates a nice thing about
AP’s Persona feature. Your workspace is
optimized for the task at hand.The clutter
caused by inapplicable tools and panels is
removed and you’re left with only what’s
needed.

Persona Comparison

23 Part 1 - Workspace Go To Serif ’s Affinity Photo HelpGo to TOC

Photo & Develop Persona Studio Panel Examples

Studio panels are an important workspace option.The
pathway to enable/disable these panels is shown at the
right:
View > Studio
This opens a long list of items that, when enabled, have
panels opened in the workspace. For example, #3,
Layers, is enabled. A click to disable and we have the
situation below - the Layers panel disappears..

As you can see at the right, there are a large number of
studio panels available. An aside - once enabled some
of them can be a challenge to find in the workspace.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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Customization Summary
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Preferences
Preferences comprise a series of miscellaneous options that are applied
across your application.They can be used to set up your own way of
working.

Tools Panel
The Tools panel can be docked or floating, on show or hidden, depending on your
preference.
The Tools panel can be customized to fit your individual way of working. By
removing tools, you can slim down the Tools panel and add available tools when
needed.

Studio Panels Each Persona's workspace can be individually customized. A panel can
be standalone or in a panel group; multiple panel groups make up a
Studio

Toolbar The Toolbar organizes some of the most commonly used commands and
functions in each Persona to keep them at your fingertips.The Toolbar
can be customized to fit your individual way of working.

Keyboard Shortcuts It's possible to customize your keyboard shortcuts exactly to your liking.
You can customize shortcuts on an application-wide or on a per-Persona
basis.

Reset Workspace 1.Tools Panel: View > Select Customize Tools; click reset in the
dialog
Studio Panels: View > Reset Studio

Workspace Customization

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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There are some skills that are necessary to
accomplish basic editing tasks.They will be
covered here in Part 2. Of course, a
prerequisite for these skills is a familiarity
with the Affinity Photo. Workspace that was
covered in Part 1. Learn the workspace and
skills.

Without knowledge of these skills, photo
editing in Affinity Photo (or any other similar
photo editing program) is not possible (or is
very limited). Please don’t ignore this
material. Without these skills, you won’t be
able to follow, nor accomplish, photo projects
like those introduced in Part 3.
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Closely related to opening images is knowing the identity
of images after they’ve been opened.This is especially true
when you have multiple images open at the same time as
shown below where 3-lines of info are available (the 3rd

line appears only when you hover over the 2nd..
You’ll see that the 3rd line illustrates various different file

types; in this case NEF (Nikon RAW), .afphoto, and .jpg.
I won’t ruin your fun by giving away the rest of the
information that’s provided..

Opening and Saving Images & Documents
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There are
several ways

to open
images:

NOTE: Win & Mac have a few differences which are
identified, where applicable, in the details provided (follow
the links in the first column below). File systems (Finder
vs. Explorer) and keyboards are the obvious examples, but
there are a few others..

Normal Open photos and raster images as well as many popular
camera raw images.

New
Document -

Create your new document by specifying a range of color
settings plus page dimensions depending on the purpose of
the document.

New from
Clipboard

You can create a new document based on the current
contents on the clipboard.

Embedded -

Embedding documents allows you to place any Affinity
(Designer, Photo, etc.), Photoshop, Illustrator, Freehand,
SVG, EPS or PDF document into your current document
without the need to open each file in turn. More later....

RAW - Open raw images to process the unprocessed image. More
in the next section, Developing RAW Images.

Similarly,
saving has
options:

Three Ways
to Save -

When you save your document all project information is
preserved, allowing you to edit it at a later date.The project
is saved as a single file with the default extension .afphoto
(analogous to the default Photoshop .psd extension - except the
.afphoto extension is proprietary, i.e. nothing can open it except
Affinity products; a real shame!)..

Follow the links in this table for full details

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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Resist the
temptation to
do additional
edits here in
Develop. For
example, the
AP Workbook
has two
Develop
examples that I
do not
recommend.
1.Tonal
Adjustment
using
Highlights &
Contrast sliders.
This can be
easily in Photos
and adjusted
later if needed
(Develop would
require a total
redo).
2. Sharpening.
Might be OK
after all Photo
editing and the
image is 100%
complete. As I
noted on the
previous page,
sharpening
should be the
last thing done.
It depends on
how/where the
image is to be
used.

Note: I’ve shot 10s-of-thousands of RAW images over a 15-
year period.The Serif raw processor is the poorest I’ve used
(Mac AP has two processors, Serif & Apple; I don’t have a
Mac so can’t compare). Caveat Emptor.
You can Google and find lots of criticism of the Develop
Persona. Much of it on AP’s own forums. Decide for yourself.
One more caution - AP’s Develop is destructive! Relax - It

doesn’t overwrite the RAW file - the original is still intact.
However, it does discard any history record of what steps you
performed during raw processing. If you want to redo
anything, you must redo everything!This is the main reason
that I avoid Develop when possible. You can load the RAW
and immediately click develop to move to the Photo Persona.

Developing RAW Images
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Go easy with the following three steps. Do only
what’s absolutely necessary - only that which can’t be

done in the Photo Persona.

Some may disagree; my advice is based on extensive
experience, prior to AP, coupled with dissatisfaction
with the Win AP RAW processor.

1. White Balance – This is Post Processing’s Job #1.
White balance removes unrealistic color casts, so that
things that are actually white in person are rendered white
in your photo. It’s essential to correct White Balance
before doing any other post-processing because incorrect
colors affect every following step adversely.
2.Exposure - Exposure, after white balance, is the next
most important post processing step to get right. Because
of AP raw processor’s performance, I suggest doing as
much as possible in the Photo Persona after finishing in
Develop.
3. Sharpening – What/how you sharpen depends on how
the image will be used. Sharpen after everything else is
done including Photo Persona editing- if you even do it at

all.
Wrap-up: I’ve tried to make clear that nothing needs to
be done in Develop, including WB as explained on
pp.32-33 (just hit the Develop button to open the
Photo Persona). In Photo, go to Layer > New
Adjustment Layer to find these
options - the same elements
available in Develop, except these
can be re-adjusted without needing a
complete redo.

The Develop Persona processes digital camera raw
images (which must be developed before editing).

When you open a RAW file, AP automatically switches
to the Develop Persona, with its unique panels and tools.
This link opens a detailed explanation of every one of
AP’s RAW Development features - a must read. After the
image is “developed”, AP automatically switches to the
Photo Persona. Here’s a good Serif video tutorial - a must
view.

While in the Photo Persona, you can switch to the
Develop Persona (even if you didn’t begin with a RAW
file). Helpful since some things can be done only in
Develop..
There are no hard-fast rules for RAW development. It’s
your image and, when you like what you see, you’re done!
However, there are a few basics to consider which I’ll
mention next.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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This is the RAW file opened in the Develop Persona.
RGB = 212/234/176

Consider hitting the Develop Persona’s Develop
button right now and move on to Photo. You can go
back to Develop later if there’s a need.

This is the above RAW file after using the Develop
Persona’s White Balance correction tool.
RGB = 235/246/240

For this image, the RAW file was “developed” in the
Develop Persona with no changes.This was done in
order to do the WB correction in Photo Persona using
its White Picker tool (found here):.
Layer > New Adjustment Layer > White Balance

With the picker, you can click on the image to indicate
where the color cast is that you want made neutral.
RGB = 255/255/234

This was done the same as the one above EXCEPT it
used the Nik Color Efex’s White Balance option
which uses a color picker with more options than the
one in AP. Dealer’s choice.
RGB = 237/237/227
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Developing RAW Images - AdditionalThoughts on White Balance

White Balance & Neutral Color
A camera captures three colors – Red, Green, & Blue

These three are combined to create every other color &
tone produced in the camera’s final captured image

Every final color is made up of from 0 to 255 parts of
each of the three:

255,0, 0 is red; 255,255,0 is yellow; and so on for a total
of 16,777,216 combinations

Neutral is any color where the RGB components are all
the same:

0,0,0 is black; 255,255,255 is white; 128,128,128 is
middle gray; and so on for any of the 256 possible neutral

values
If you need to fix colors in post processing the simplest

and most accurate way requires a neutral reference:
Which you can click on with a color picker (assuming your

program has one).

Without a known neutral reference, all bets are off.
You don’t need a reference in each and every photo
Just every one that’s in a different lighting situation

Many programs will save the reference image’s correction
for use in the rest of your photos - so the bride doesn’t

have to hold a reference card in every photo :)
Extra Credit - Who painted my white bath orange???

I’ve more to say related to Develop in a later section, Masks &
Overlays. Overlays, available only in Develop, perform a
function similar to masks (call it “Masks for Develop”).
Another example of potential problems caused by the fact that

Develop actions are destructive and can’t be adjusted without
redoing all prior Develop actions. Develop needs some serious
re-development IMO and not just a better processor. Please,
Serif.

What’s the above “neutrality” piece all about? It’s about
realizing the cast can appear and be corrected on any of
256 colors - not just white - when using a color picker
(which AP has in Photo, but not Develop. Why not?).
The purpose of white walance correction is to remove
color casts. Yes, you can use it to introduce or exaggerate
casts but, first and foremost, the ability to make colors
neutral is an absolute must.
A white balance editing feature, like AP’s and many

others, based on adjusting color temperature and tint may
not be adequate.
There are alternatives such as the bottom two at the right
- both use color pickers.The RGB values for each were
measured at the same spot on all four images. What we
want is R=G=B, i.e. Neutral! The greater the deviation, the
greater the cast. By this measure, the Nik version is best.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://edknepleyphoto.photos/2010/03/17/color-as-captured-in-the-camera-part-2/
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CONTEXT TOOLBAR FOR CROP

An example Unconstrained crop.
Options, like Unconstrained, are set in the context toolbar.

The composition-aide overlay changed from thirds to Golden-spiral.
The image ratio is now 1:1 (square); set in the context toolbar Mode

option.When you are done with the crop, press
the context toolbar’s Apply or

Cancel buttons.

Crop is non-destructive.
“Uncrop”with “Document > Unclip

Canvas”.

Cropping
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All About AP Cropping - read this for an excellent explanation & demo.
This first image shows the screen after opening the crop tool.

The overlay is the Thirds Grid. Several are available via the context toolbar.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_crop.html?title=Crop%20Tool
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These two brushes both are used for removing defects
and general retouching.The big difference between them
is that healing blends the target pixels with the sample
pixels by matching the texture, tone, and transparency of
the sample pixels with the target pixels..
In most cases, the healing brush is the one to use.There’s
not much, if anything, that it can’t do as well or better
than the clone brush.
The Patch Tool is similar to the healing brush tool.

Instead of brushing, it uses AP’s Selection tools. It allows
you to repair an extensive area of an image by selecting
pixels and replacing them from another target area.

Cloning and Healing Brushes (read the complete story here)

Done with Cloning Brush (and the
Sources Panel)

Many of us are familiar with the “old
standard”where we did an alt-click in one
part of an image and then painted that into
another part of the same image. We also

remember the problems due to mismatches
caused by tonal differences.. Weep no more

- auto blending is here.
And there’s more. A sources panel (found
at View > Studio) can contain multiple

global clone sources,These clone sources are
available to the Clone Brush Tool, Healing

Brush Tool and the Patch Tool.
Above is an overdone example that adds

clones from the Source Panel shown at the
left.

Here’s a helpful Serif video explaining the
Source Panel

Read about the Sources Panel

AP’s six image repair tools are near
the bottom of the tool bar in two

parts as seen at the left..
The first, the Clone Brush, has been
around in the image editing world
forever. I think AP just brought it

along for us old timers. :) The
biggest difference between it and
the others is it doesn’t provide the

automatic blending or texture
matching.that the others do.

The other five are represented by a
single icon on the tool bar.The icon
is the one for the last of these tools
you used.The remaining four tools

are seen by clicking the black
triangle at the bottom right or by
pressing/holding the visible icon.
Each of the tools are designed to

solve different problems - like Red
Eye.There is overlap between some
tools.The first four, shown at the
left, are examples of tools which

overlap to some degree.
Here is a truly great detailed article

on the topic of AP image repair
tools. A must read.

Image repair tools
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Removing Red Eye
Detects red coloration in a subject's

pupil and instantly removes it.
Simple and effective

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_patch.html?title=Patch%20Tool
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https://affinity.help/photo/en-US.lproj/index.html?page=pages/Panels/sourcesPanel.html?title=Sources%20panel
https://www.azuloxworkshops.com/educational/affinity-photo/affinity-photo-image-repair-tools/#affinity-photo-image-repair-tools
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Tools/tools_redEye.html?title=Red%20Eye%20Removal%20Tool
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Inpainting BrushTool

This is my usual go-to tool. Conversely,
I rarely use Patch. Red Eye and

Blemish both have their place, but I
rarely photograph people.

That leaves Clone and Healing to round
out AP’s set of six image repair tools.
These two are very much the same.

Healing is basically a more
technologically advanced version of the
Clone Brush. The biggest difference is

that Healing, and its four partners,
blends-in the repair, while Clone just
copies from your source point to where

ever you want repaired.

Above & at the right show the
simplicity and quality of Inpainting. I
simply painted over the three before areas (one at a
time) and Inpainting did the rest. I did a minor tree
trunk touch-up near the bottom right repair area
after inpainting because Inpaint’s auto-blending

caused a smear when it tried to blend the light sky
with the dark trunk - Clone to the rescue.

The set of images below show copying of the bud at
the bottom left - 1st three by H and the last by C.

Clone does an identical source copy regardless where
you copy it. Healing doesn’t. It tries to blend with

the surrounding area and goes from bright to dark as
it moves further from the main flower.

https://affinity.help/photo/en-US.lproj/index.html


AP is compatible with a number of Photoshop plugins
(check this list). Here are Mac and Windows installation
tutorials for Nik plugins. Use Edit > Preferences and

then select Plugins for the installation of all other
compatible Photoshop plugins.
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Adjustments and Filters (which include Plugins)

Affinity Photo editing depends on the use of
Adjustments and Filters which, in turn, use
Layers. Bottom line: before you can use AP well,

you need to understand these three. No getting around
it! That said, a brief introduction is called for. (If you’re a
Photoshop veteran, except for a few details, this is
nothing new.)

What follows is only a sketch. Repeating Serif ’s
documentation is a waste of time - mine and yours. I’ll
point you to it when useful. Otherwise, my goal is to
show the things that can be done with AP’s tools. Serif
teaches you how to use a hammer to drive nails. I want
to show you how to use the knowledge they impart to
make useful things - like a house. Moving on...

http://www.miguelboto.com/affinity/photo/plugins-support/
http://player.vimeo.com/video/203995108/
http://player.vimeo.com/video/204900420/
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/English.lproj/index.html
https://forum.affinity.serif.com/
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Destructive Filter

Note that there’s no
new layer after the
filter was applied.

Understandable
since image changes
are made in via
layers. For a change
to be non-
destructive, it has to
be made in its own
separate layer. See
one here? No you
don’t!

Live Filter

Note that there is a new
layer after the filter was
applied, a child layer.

The filter’s layer is what
makes this filter non-

destructive. Changes to
the image are made in
this separate layer and

not to the original image
layer as was done in the

example above.

The filter settings can be
changed by double

clicking the new layer -
or hidden or deleted

entirely. It’s live!
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An Adjustment Example

Adjustments are more straight-forward than filters.
They are all non-destructive, regardless of whether
selected from a panel or from the main AP menu.
The same adjustments are available in both places,

albeit arranged in different orders.

There is one difference you’ll notice in the Layers
Panel between an Adjustment and a Live Filter.
Look at the new layer each adds. An Adjustment
creates a regular layer, but Live Filters add a child

layer (destructive = no layer). Why child vs regular?
(Covered in Part 2’s Layer section.)

Adjustment vs. Filter Comparisons

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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#2 - Applying an Adjustment
If an adjustment is made to the image via
the Adjustments Panel, a new layer is added
automatically to the Layers Panel.
You can edit the settings of this panel as
well as turn it off or delete it..

Here’s the access to the
Adjustment Panel

The same Adjustments
are also found at

Layer>New Adjustments

#4 -Apply a Nik Plugin
If you manually created a new layer as shown
in step #3, and applied a plugin, here’s the
result. Note that I blended this layer with
those below to illustrate an added benefit of
this approach.
Here’s the Live Filter panel.

The main menu’s Filters
selection has all of the

Filter Panel options - and
more.
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#1 - Load a new jpeg image
After a new image is loaded, a new layer
is created in the Layers Panel
Very Important! Plugins are not active
unless the image format is a jpeg, tiff or
png.This means that if you’re still
working with a developed RAW file, you
must export it to one of those three
formats and open the new file.

#3 -CAUTION: Applying a Filter
Here is where you can get in trouble. If
you apply a regular filter (plugins are a
type of filter) the results are destructive,
i.e. the changes can’t be undone. Use a
Live Filter if this isn’t what you want.
Live Filters create new layers as do
Adjustments shown in step #2.
Unfortunately, plugins aren’t available as
Live Filters. You must create a new layer
for the same effect. To do this, in the
Layers panel select Merge Visible to add
a new layer a step above the selected layer
as shown here.This new layer is a merged
copy of all visible layers and is where you
apply a plugin..

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/English.lproj/index.html?page=pages/Layers/livefilters.html?title=Using%20Live%20Filters
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Lots of options from several locations.
Be sure you know the differences.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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See the next page more about these four items

Selections - This is where the power of Affinity Photo
shines. When we want to edit, it’s usually not a global
edit that we want, i.e. not the entire image. More often,
we want our editing changes to be applied to a specific
portion of the image - enter selections!
A selection is a drawn area on your image bounded by a

flashing dashed line. A selection can be used to:
Limit editing to within the selection (see example)
Selectively copy pixels
As a step in creating a mask layer (see example)
Draw areas for removal.

Selections

Creating, Modifying and Refining Selections
Follow the above link for the complete AP official documentation on

Selections. Also, here a links to official Affinity videos:
Making Selections
Refining Selections

Pixel Selections from Layers
Freehand Selection Tool

Channels: Creating/Storing Selections
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Selection Menu

Selection by Flooding

Selection by Painting

Selection by Drawing

4 Selections by Marquee

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_create.html?title=Creating%20pixel%20selections
https://
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_create.html?title=Creating%20pixel%20selections
 https://player.vimeo.com/video/130975378
https://player.vimeo.com/video/130974710
https://player.vimeo.com/video/130973473
https://player.vimeo.com/video/194652359
https://player.vimeo.com/video/155542288
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_flood.html?title=Flooding%20pixel%20selections
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_create.html?title=Creating%20pixel%20selections
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_freehand.html?title=Drawing%20pixel%20selections
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Selections/selections_marquee.html?title=Marquee%20pixel%20selections
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The Roles of
Selection in this Image

The lightening of the foreground cliff face
is an example of a non-global change.The
selection took less than 10 seconds using

the selection brush. Adjusting the exposure
within the selected area took a minute.

Easy, peasy.
Adjusting tones and colors are fairly

common editing tasks. Another editing
task, replacing entire parts of an image, is
less common. Sky replacement, as shown

here, is an example.
The sky was also selected with the selection
brush tool. Once selected, it was converted
to a mask layer (see image below).The sky
replacement was completed by adding a
layer at the bottom of the layer stack and

placing the new sky into it. .
Place close attention to the order of the
layers. Covered in a later section (masks
cover content in layers below them)..
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Kings Canyon
National Park

At 8,200 feet deep, it is 2,000
feet deeper than the Grand

Canyon. It’s the deepest canyon
in the United States. Almost a

mile and a half.

The drive from top to bottom,
shown here, is interesting. “Slow
down” says my back seat driver.

The depth, together with steep
vertical cliffs and the winding
road, make for some extreme

lighting contrasts as shown here.

More often than not, we want
our editing changes to be applied

to specific parts of an image
rather than the entire image.

That is illustrated here (and see
the previous page for more

detailed start-to-finish steps).

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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BEFORE

AFTER
A slight

alteration of the
reflections.

Below -Image and layer
stack as they appear
immediately after

applying the Motion Blur
Live Filter

Alternative Adjustment Methods
Although AP’s adjustment options
are good, it’s worth knowing about

some alternatives.The Nik
Photoshop plugin is just one

example (and it’s compatible with
AP).

Read Selective Adjustments – A
Comparison of Alternative

Methods

A layer mask hides parts of a layer.This allows you to
(non-destructively) remove things. AP has two types of
masking.:
Pixel masking: can be modified, or discarded at any time..
Vector masking: uses vector content as a mask over
another layer which crops to the vector content's outline.
Masking can be applied at any level in the Layers Panel:
As an independent mask layer or
Applied to a specific layer or to a layer group.

This depends on mask layer's position in the layer stack.
More on Layers in the next section

Layer Masks & Masking
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1. What does a mask look like? Like the two images at
the left.The top image goes with the
image on the next page.It’s soft-
edged, hand brushed.The bottom
mask goes with the previous
Selection section’s Kings Canyon
image. In contrast to the top mask,
the latter one is highly refined;
there’s no way the tree on the cliff
top could been hand drawn. Fine
detail wasn’t important with images
on the next page where I just wanted
to alter the reflections.These two
masks are meant to illustrated the
role of selection when working with

masks.
2. Now to the example at the right.
Start by loading the image.
Next open the Motion Blur Live Filter and make some
changes.
This bring us to the next image (center of page). Note
that a new child layer has been added as a result of the
previous step. It’s all white and the resulting image shows
the motion blur thoughout. BUT - we only want the
blur applied selectively.
Remember white reveals & black conceals. If we invert
the mask, it will become all black (Layer > Invert) as
shown here. Once it’s black, the image reverts to the

original loaded
version (the motion
blur’s been
concealed).
Now for what we
started out to do.
Grab the Paint Brush
Tool.
Make sure that white
paint is selected.
Paint the image in
the areas where
motion blur is
wanted.
Note that the inverted
mask’s color changes
to white (revealing the
motion blur in the
reflections).

123

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://edknepleyphoto.photos/2019/09/15/selective-adjustments-a-comparison-of-alternative-methods/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Layers/LayerMasks.html?title=Layer%20masking
https://affinity.help/photo/en-US.lproj/index.html
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Adjustment Layer Masks

Adjustment layers were discussed in a earlier section. Left unsaid
there is that adjustment layers are very useful when it comes to
masking. Adjustment layers have mask layer properties. Areas of
an adjustment layer can be revealed or hidden in the same way as
with a mask layer.
To mask an adjustment layer: first select the desired adjustment
layer on the Layers Panel. Then Layer > Invert and
Use the Erase Brush Tool to erase
Use the Paint Brush Tool to restore
The two adjustment layers, shown above, were used as masking

layers to convert the the original image at the left,
An HSL layer was used to enhance the shop’s colors.
A B&W layer was then applied to convert the image to all B&W.
Last, the Erase Brush was used on the B&W layer to reveal the
main window’s color.
Note each layer’s thumbnail.They show each layer’s mask which
reflects your brush work. Recall that black hides which is seen in
the erasure of the B&W adjustment over the window.
Not the greatest editing choices; done to illustrate the adjustment
layer masking and not to make a great image..

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Layers/adjustmentLayers.html?title=Using%20adjustment%20layers
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Mixing It Up
Two selection tools:

Rectangle Marquee to select the
lower tulips. But - I also wanted the
leaves of the top tulip to be selected
AND its stem to not be selected.

Brush tool was used to reshape the
rectangle (the horizontal marching
ants in this image >>> are the top of

the original rectangle.The brush
“carved” it to solve the issues in #1

above.
Two masking layers, as shown at the
right, a live filter and an adjustment

layer, to finish things off.
The mixing & matching possibilities

are endless.
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Live Filter Layer Masks
There is almost no difference between
the Adjustment Layer masks of the

previous page and the Live Filter mask
described here. Both are added in an

identical manner. Once added, they are
manipulated in an identical manner.They

differ only in the editing tasks they
perform - adjustments vs. filtering.

Here, a Diffuse Glow filter was used.The
goal was to brighten the person in the

foreground - just the person. After
applying the filter to this infrared image,
the filter was inverted and a white paint
brush (white reveals) was used to show

the filter’s effect per my goal. Look at the
filter layer thumbnail, at the left, and

you’ll see the revealed white area of the
mask. s

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://
mailto:https://affinity.help/photo/en-US.lproj/index.html?page=pages/Layers/livefilters.html?title=Using%20Live%20Filters
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Layers/livefilters.html?title=Using%20Live%20Filters
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Layers are of paramount
importance in Affinity

Photo. I could write a book the
size of this eBook just on layers
- but won’t. Instead, I’ll guide
you to Serif ’s own materials, and
refer to their relevant details in
Part 3 of this eBook,AP
Example Editing Projects.
Below, I’ve listed everything
(literally) of importance that
Serif has published about layers.
Better from them than me.
First, there’s the Affinity Photo
Help that is available from the
program’s Help menu - read All
About Layers
Next, a dozen video tutorials:
Basic of layers
Advanced layer options
Selecting layers
Mask layers
Luminosity masks from layers
Masking vs clipping layers
Isolating layers
Sky replacement
Fill layers
Masking adjustment layers
Live filter layers
Paste/move inside (composites)

Layers are one of the most important parts of Affinity
Photo (and every other Photoshop-like program).They
are used to separate different parts of an image, which is
the key to a nondestructive workflow. Each part can be

edited (and reedited, hidden or deleted at any time in
the future) independently of the rest of an image’s parts.
Understanding layers is an absolute must!

Layers
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New Sky (pre-mask)

HSL FlowersImage as Captured

Brighten meadow behind flowers HSL Mid-ground Trees (luminosity)

Bright/Contrast Mountain

Seven layers separate different parts of this image.Each layer is
used in the editing of a part - without altering (destroying) its
underlying part. Don’t try this using the Develop Persona’s

Overlay Tool. You’ll get similar visual results, but will
permanently alter (destroy) the image layer being edited..

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Layers/aboutLayers.html?title=About%20layers
https://
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/311178905
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/331996190
https://
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/310764355
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/332168517
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/317427603
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/318402519
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/329304171
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/332653469
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/332646026
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/310549897
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/311405882
https://affinity.serif.com/en-us/tutorials/photo/desktop/video/318783150
https://affinity.help/photo/en-US.lproj/index.html
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Live Highpass Filter
The before half of this image

is the after-image on this
Layers Section page.

Old Rag Mountain
Shenandoah National Park

Live Clarity Filter
Sharper and brighter.The after

tone is warmer (not my
intention).

If you’ve read Serif ’s Affinity Photo Workbook, you
probably noticed that I’ve followed (nearly) the same
table of contents to this point, in terms of organization.
It’s only for that reason that I’ve included Sharpening,

which is not high on my personal list of skills. If you’re
printing the image, then sharpening may be appropriate
as a final editing step. Here are three examples, each using
a different tool.

Before After

Sharpening
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1. Open the “before” image
Apply the Unsharp Mask get the “after” image
Invert the mask and use the rectangular marquee
to repaint the after-half of the image white.
Draw a white line (w. rectangle tool) between the
before & after halves.

I chose this 1” high subject, because it was full of
tiny details. I chose to go easy with the strength of
the sharpening. I also used the blend mode option
to lighten things a bit. FWIW, the title is Strange
NewWorlds,

Macro - 1 inch high stained glass Global Contrast for Fine Detail

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://
https://affinity.help/photo/en-US.lproj/index.html
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Original Levels Contrast Colors Level, Color, Contrast Contrast, Color, Level

The six images above provide an idea of what these adjustment do.The
last two were added per the suggestion in the AP Workbook to try
several enhancements at one and to try them in a different order. Not
anything useful in may opinion.
You are infinitely better accomplishing the same thing with AP’s
nondestructive adjustments and live filters that give you complete
control and are nondestructive.

Caveat emptor!

Automatic Adjustments
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The screen shot below is from the top AP toolbar. It shows the four AP auto-
adjustments. I’m not sure why anyone would use these.The results, IMO, are
unpredictable in the sense that your only control is to turn one or more of them on
- that’s it, just ON.The worst thing about them is that they are destructive..The
only way to undo them is via History - undo everything you’ve done all the way
back to when you activated the auto-adjustment.
Adjustments, L to R,Levels, Contrast, Colors, White Balance

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
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The next page is an example of the type of content that will appear here in Part 3.

PART 3 - Example EDITING Projects 66

Out of Frame (OOF) 67

Multiple Exposure (painterly images) 71

Multiple Exposure (soft flowing water) 75

Tonal Punch 77

Brightening with Curves plus Tweaking Color & Tonal Contrast 85

INDEX 93

PART 3 - EXAMPLE EDITING PROJECTS
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Editing this image Refer to the Selections, Masking,
and Layers sections of the User Guide guide if needed
1. The right (& wrong) way to start:
OOF requires a Frame. Don’t begin with File>Open -

there’s no matte that way. Do begin with File>New using
a suitable document width and height. Here, I use a 2000
px square “matte” and will crop-to-suit later. Next open
your image with File>Place.
Drag & place it on the
“matte”, being certain to
leave room for the final
matte..
2. Now it’s edit-time.The
1st step is to mask out the
OOF portion of the image.
3. I used the selection
brush to create the mask
layer shown in the left-hand image. It’s shown alongside
the original image.The
dashed-line is where top of
the matte-opening will be.
Note that the mask layer
extends below this point.
You’ll see why shortly.
Below the two images is a
screen shot of the layers panel
at this stage of the process.
Note the child mask layer and
recall that white reveals.
Important note - when
masking, be sure to set the
mask Refine option’s Output
Setting to New Layer with
Mask.That’s what gives us
the top two layers in the

previous Layers Panel screen shot. We’ll see in a minute
why that’s important -
it’s not the same as the
Selection output option
used in earlier sky
replacement examples..
4. Next? Replace the
area above the red line in
the previous screen.
That’s easy due to how
we created the mask.
Remember when we
outputted a New Layer
withMask using the
mask Refine option?
Here’s where the result of that step pays off.
Hide the mask layers; select the desired OOF portion of
the image using the rectangular Marquee mask tool;
remove the selected
portion with Erase
Brush.That changes
the original image to
the right side above.
To finish, show the mask and, voila, there’s our OOF.
5. FinalTouches The main tasks are done. Prettying up
is all that’s left to do.The first thing to do is crop-to-suit.
After cropping I usually do two more steps - add depth
to the matte’s opening and frame the image.The Layer
Effects panel is
perfect for the
matte.� I use its
Outline, 3D, and
Bevel options.The
Rectangle Tool
provides the easiest picture frame.Enjoy!
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Out of Frame (OOF)

Frame, in OOF, is the photo
matte. OOF means the image
extends beyond the matte’s
opening. You may find the
above link’s 10-year old
material interesting.
For the art historians out there,
long after I started doing OOF
I came across this painting. It’s
called Escaping Criticism
(even in days of yore art judges
weren’t looked upon kindly, it

seems). It’s an example of a
style called “trompe l’oeil”
(French for “fool the eye”)
which is more descriptive than
OOF, I guess.
Pere Borrell del Caso (Spanish,
19th century), Escaping
Criticism, 1874, oil on canvas,
Banco de España, Madrid. In
advance of art criticism, this
boy (the painting itself )
appears to escape his (its)
frame.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://
https://
https://
http://bit.ly/2klPSpD
https://affinity.help/photo/en-US.lproj/index.html
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Multiple Exposure (painterly images)

As the title suggests, this is about multiple
exposures. How many? It’s up to you and
depends on what you’re trying to do. For
painterly images, like this one, somewhere
between 5 & 10 works well. In this case,
there are 6 exposures.
Obviously, some differences are needed
between the exposures. In this example,
the camera was panned down vertically
while snapping six exposures (see top).The
two images at the right are the first and
last exposures and show the length of the
pan.
There’s no right or wrong in the capture
decisions. You need to experiment and
learn what works best for your needs.
OK, you’ve captured your multiple
exposures. Now what do you do with them
in Affinity Photo? Read on...

It’s all about Stacks!

1. File > New Stack
2. Essential - Turn
OFF Automatically
Align Images
3. Click Add - select &
open your images
4. Click OK

5. Your stack is
automatically
blended in a layer
group as shown here.
6. Any settings,
adjustments or
filtering past this
point is up to you.
The next page has a
few examples.

4321

1

2

3

4

Median Maximun

Stack operator settings are shown at the
top left. Access them via the screen shot’s
circled item. Follow the link on the
previous page for details. For images like
this Median & Maximum are usually best;
I used Median.
Adjustments & Filters apply just as with
any image. I used four for demo purposes,

applied in the order shown.The location
of their layers is important, as always. In
this case, note where the two live filters are
located. If moved above the Live Stack
group, with the adjustments, the filters
cease to function. Experiment.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://edknepleyphoto.photos/2011/09/08/multiple-exposures-made-easy/
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Stacking/stacks.html?title=Image%20stacks
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The image on the left is the result
of the four adjustment and filter
steps shown at the bottom of the

previous page.
The image on the right took a

“darker-approach”
Obviously there’s no right or
wrong. What sings to me may

sound like nails on a blackboard
to you.

If you like what you’ve done,
that’s what matters (not what the

judge likes).

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html


Here’s a technique that’s useful when stopping down the
camera’s lens and/or using neutral density filters don’t give
the long shutter speed needed. It’s equal parts camera and
Affinity Photo. A tripod is almost essential as you want
only the water to be moving.

Here’s how to do it. Put your camera on a tripod, set the
release mode to continuous, and fire off a string of
exposures.Ten is good.These exposures, when combined
into a single image, will appear to be identical to that
achieved with a single long exposure.

Use Affinity Photo’s Stack feature to blend the moving
water multiple exposures as explained below.

Interested why this works, and are math/statistically
inclined, look up ergodicity.

• Ergodicity means the ensemble average equals the
time average - not too helpful, right?
• Ensemble averages, multiple exposure in this case
• Time average, the long single exposure in this case

• When are they equal?
• They are equal when the process is ergodic.

My assumption that the flowing stream is an
ergodic process may be arguable (but I'll stick to
my guns based on the visual results).

A photography and science lesson all in one
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Multiple Exposure (soft flowing water)

Cotton candy flowing water may be a photo-cliche, but
it's popular never-the-less.There are two ways to get

this effect.The first is well-known - just use a long
exposure. However, you can’t depend on always getting the

needed long exposure - for lots of reasons.The second will
come as a surprise. It’s this technique that we’re interested
in. If you use Affinity Photo, the technique is always
available and will always work..

Once again, as in the earlier painterly
image multiple exposure item,

It’s all about Stacks!

1. File > New Stack

2. Essential - Turn OFF Automatically

Align Images

3. Click Add - select & open your images

4. Click OK

5. Your stack is automatically blended in a

layer group. Any settings, adjustments or

filtering past this point are up to you.

Except for the photo content, painterly
images vs cottony water, there is no
difference between the editing process for the
two multiple exposure techniques presented
here and in the previous section.

The main reason for adding this section on
water was to introduce how an ergodic
process, the flowing water, can apply to
photography through the use of multiple
exposures. Had you ever thought of blending
multiple exposures to create cottony water?

Refer to the previous section for more...

Hey, how about using Stacks to send secret
messages? Think about it. I love Stacks. Here are thirteen of my photography articles related to motion.

Search for “motion”.The articles are there under that heading.

https://en.wikipedia.org/wiki/Ergodicity
https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://
https://
https://affinity.help/photo/en-US.lproj/index.html?page=pages/Stacking/stacks.html?title=Image%20stacks
https://edknepleyphoto.photos/table-of-contents/
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This user guide is modeled after Serif ’s Affinity Photo Workbook.This specific editing example follows the workbook’s first
editing example’s steps.

Tonal Punch

The curves adjustment took us from the top left to the right.
So far, so good. Next, let’s work on tones and contrast.

With the background layer selected, Select > Tonal Range >
Select Midtones.This gets you marching ants. Next,Layer >
New Adjustment Later > HSL and
play with the HSL controls to get
the look you want (turn off the
ants,Ctrl-D, to better see the
changes as you make your
adjustments). What I wanted is
shown at the left.The layer panel
is shown to the right.

View looking west from Skyline Drive across the
Shenandoah Valley toward the Appalachian range’s
Massanutten Mountain.The valley is nearly 2000 feet
below.The redbuds, on a cliff 100 feet below in the

foreground, mask the height.The captured image
accurately reflects what I saw (except the rain), but for
purposes of this example I’ll add some tonal punch (the
workbook author’s, James Ritson, words).

Even though the histogram below indicates correct
exposure, the image could use some brightening. Although
many of you use the levels adjustment for this, nothing
compares to curves - curves are levesl-on-steroids.

That said, clearly our first “punch” should be a curves
adjustment.

The curves adjustment below recognizes that the darker
areas of the image (left-hand peak) are most in need of
brightening. In fact, brightening the image’s upper left will
quickly burn out that area’s sky, so for starters, let’s begin as
shown here. Lots of time for fine tuning later.

https://affinity.serif.com/en-us/tutorials/photo/desktop/
https://affinity.help/photo/en-US.lproj/index.html
https://edknepleyphoto.photos/2013/06/28/contrast-part-6-levels-and-curves/
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The above step is one that James R. uses to separate color
tones for a dramatic look (paraphrased).The technique
involves combinations of blend modes, adjustment
techniques, and opacity levels - and experimentation with

various combinations of them. In this case, I used B&W
adjustments, Overlay blending and an Opacity of 61%,
paralleling his example (except for the B&W settings, due
to the difference in our image colors & tones).

The sky was a bit difficult, both in capturing and editing.
For editing, any sky, not just this one, is best left until near
the end of the editing process. Although the wispy mix of
whites and grays fits the story of a mountain storm, I
decided to add some punch here as well - just a small
touch using the clarity live filter in the top image.This
wasn’t necessary, but...

A couple of things to note regarding the clarity filter’s layer:

• Unlike the previous adjustment layers which are
placed above the background layer, the filter layer is
below it (else it doesn’t work)

• The layer is masked.The top portion is white (reveals)
thus limiting the filters clarity action to the sky. I left
the ant’s on for you to see,

Here we see a bit less brightness and
slightly more contrast in the lower image.

This was done using a selective color
adjustment layer. I chose the White Color
Pop Up menu and dragged the black slider
to the right.

Again, not necessary, but you can’t learn
without experimenting.

A final step - the Unsharp Mask live filter.

This is a step that I personally avoid until
I’m ready to display or print the image.

However, since I’m following James’s tonal
punch recipe and since the filter is non-
destructive, there’s no harm.

The bottom image is with filter on,
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This is how things really
looked

The after is extreme IMO,
but OK for illustrative

purposes

Copy this before-image and
try it yourself.
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Brightening with Curves plus Tweaking Color & Tonal Contrast

A dark rainy (~ 4”) autumn day in a
Maine forest (my kind of day). Me
and my gear were ready and dressed
for it. I was pleased with the result
except for the upper right quadrant
and lower left corner. What little
light there was came from the right,
leaving these two area in heavy
shade. Not a problem. After a
simple curves adjustment and a few
color & tonal contrast tweaks, it
was a keeper.

Now, it’s ten years later, and I’m
looking for images to try with
Affinity Photo. I pulled out this
Nikon RAW file and did nothing
more, for a start, but convert it to a
JPEG - no adjustments made
during the conversion.That JPEG
is what you see at the upper left.

The image at the bottom left is the
Affinity Photo result.This example
will show the steps used.

The RAW conversion was done using
Adobe Camera Raw with an ancient
copy of Photoshop Elements 11 which
I bought years ago. I use(d) it for
conversion and as a host for the Nik
software suite. I’m an experienced
photographer and have converted
tens-of-thousands of RAW files with
no problems - until I tried AP’s
develop persona, that is.

Before going any further, I wanted to deal with
the image’s two dark area.The lighting doesn’t
match the rest of the image. It needs to be more
even.

It’s best to fix this first, before making further
adjustments. Saving it until later risks having
this, as a last minute adjustment, adversely
affect earlier changes.

I’ll do this brightening in two steps. First, a
global brightening using the curves adjustment.

The dark area still need some help.The HSL
adjustment layer can provide help with colors,
especially lightening the greens on the far bank.
Once done, you’ll see that the already-light left
bank also got included.

Here’s an easy way to fix that selectively. Select >
Tonal Range > Select Darktones to get the
marching ants.Next, use the adjustment layer’s
mask property to mask out everything except
the far bank (see the
layer’s panel to the
left - black
conceals). Remember to
set the brush hardness to
zero for a soft edge
between the light and dark
areas..
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Nik Silver Efex Pro B&W image made using SEP preset #015

The layer containing the image is at the top of the layer stack
using Luminosity blending and an opacity of 33%

This final step uses the Nik Silver Efex Pro plugin to create
a B&W image (SEP preset #015).The blend mode, for the
resulting B&W, is set to Luminosity with an opacity of
33%. Explanation is here (also, check the note in the
screenshot above).

The no-plugin alternative is to skip theMerge Visible step &
create the B&W image using an AP adjustment layer like
Black and White. But, for a good B&W image, nothing
can match Nik’s SEP.
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This is the captured version.

Copy it and follow this
editing example yourself.
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